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Administrators Manual
While the Users Manual describes issues of the usual work with phpVideoPro, the Administrators Manual
will help you to manage the application. This involves the following topics:

Installation, updates and "get the application running"• 
User and Session Management• 
Data Administration (Backups, Cleanup, …)• 
Translation Management (localizing the application)• 
Administration of technical data (media types, sound formats available, categories, etc.)• 
PSLabel Template Management and LabelPacks• 
Configuration of Application Defaults• 
Filter Defaults• 

Installation

Requirements

There are a few dependencies to consider in order to use phpVideoPro:

a Web server supporting PHP (tested only with Apache)• 
PHP5 (recommended: PHP 5.2+ as loadable module for Apache - which again is the only tested
variant) compiled with support for the database to use

• 

optional: IMDBPHP classes installed in the servers PHP include_path• 
a database which may be remote or local, supported are MySQL 3.28.32 and higher (recommended:
v5) as well as PostgreSQL 7.1 or higher (starting with v0.9.5, SQLite is an additional option, but not
fully tested yet)

• 

Most (if not all) Linux distribution ship this along with their package manager (for IMDBPHP you will need
the IzzySoft Apt Repository IzzySoft Apt/YUM Repository configured), so it should be easy to install. On
Windows it might be a bit more tricky. To test whether you meet these requirements, simply create a test PHP
file containing a single line: <?php phpinfo();?>, put it into your document root, and call it with your
browser. The resulting page will list your PHP configuration and tell you about available capabilities.

Installation

Recommended Installation Path

The best (and most recommended) way to install phpVideoPro is to use your Linux distributions package
manager. There are *.deb and *.rpm packages available in the IzzySoft APT repository, and you can even
include this repository in your APT or YUM configuration (this is described on the webpages there). Doing
so, all dependencies will be resolved automatically, and installation is done by a single command (apt-get
install phpvideopro or yum install phpvideopro will perform all necessary steps).

If you can neither use *.deb nor *.rpm packages, you should download the TAR archives (IMDBPHP and
phpVideoPro). Having these unpacked, change to the directories created and run make install after
making sure that all dependencies are met.

All these mentioned methods have at least two advantages over the manual installation:
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all files will automatically be put to the right places• 
everything can be easily cleanly uninstalled (apt-get remove phpvideopro, yum remove
phpvideopro, make uninstall)

• 

Using *.deb/*.rpm packages with the repository moreover will allow you easy updates.

Manual Installation

If you prefer to do a manual installation, you first need to make sure all requirements are met. Then:

Unpack the TAR archive to the directory of your choice. This must either be inside your web servers
document root, or linked there (and the web server configured to allow that - FollowSymLinks in
the Apache options), or set up in your web servers configuration as an Alias

1. 

Rename the inc/config.sample file to inc/config.inc and optionally edit it to reflect
your structures - which can also be done by the configuration wizard (see below)

2. 

Start the configuration wizard by pointing your browser to the setup/install/index.php
file. This will initialize your configuration, and setup the database. At a later time, you may also want
to use the wizard to restore a previously saved backup

3. 

Change the Admin Password immediately after completing the wizard from its initial value (video)
to something else, so nobody can access the application with admin privileges but without your
consent

4. 

Protect your installation so no unprivileged user will be able to run the wizard. This can be done by
either

remove the setup/install directory♦ 
setup a protection by your web server (e.g. by using a special .htaccess file (there is
already an example file placed inside the directory) or specifying corresponding options
directly in your web servers configuration

♦ 

change the permissions of this directory using the chmod command, e.g. chmod 0700
install if the web server is not its owner

♦ 

5. 

If you are concerned about disk space, you may want to remove language files for languages which
you don't need (setup/lang_*.sql). This will free some hundred kilobyte at maximum. And you
must not delete the English language file (setup/lang_en.sql), since this is the only one really
required.

6. 

Permissions for some directories need to be updated: When retrieving data from the IMDB sites,
you probably want to use the images as well. To have this working out-of-the-box, the corresponding
directory (moviepic/imdb) is made read/writable for all users - which may be a security risk. It
must however be read/writable for the web server, so your options are:

leaving it as-is since it works (implying the security risk)♦ 
as root, change the ownership of this folder to the web servers user (e.g. chown
www-data:www-data imdb) and then revoke the permissions from the group and others
(e.g. chmod 0755 imdb or, for paranoia, chmod 0700 imdb)

♦ 

change the owner group only (lite-version of the previous option) by e.g. chgrp
www-data imdb and then set the permissions correspondingly (e.g. chmod 0775 imdb
or chmod 0770 imdb)

♦ 

7. 

Finally, you may want to install additional templates for the label printing - which may be done from inside
the application and will be explained with the configuration (and not installation).

Updating

Depending on how you performed the installation, updating from a previous version of phpVideoPro can be
done in different ways:
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Using your package manager (apt-get update phpvideopro, yum update
phpvideopro

• 

using the Makefile (make install)• 
manually copying the files from the Tar archive• 

In any case, you afterwards need to run the update manager by pointing your browser to the
setup/update/index.php page.

Configuration

Web Server

First, there may be some adjustments needed for the web server. If you run Apache, and its configuration
permits you to specify options for the directory phpVideoPro was installed into (i.e. AllowOverride
Options or AllowOverride All is set for this directory), this is done automatically by the shipped
.htaccess file. Otherwise, you have to take care for this manually using one of the following options:

changing your Apache configuration to permit the use of options by a .htaccess file1. 
changing your Apache configuration by copying the options from the .htaccess file to the
appropriate section there

2. 

apply the changes mentioned in the .htaccess file globally in your php.ini3. 

If you decide for b) or c), you should remove the .htaccess file afterwards to prevent an Internal Server
Error (500) when Apache finds it but doesn't allow the options to be applied. To help you with your decision:

b) and c) are slightly faster than a)• 
a) gives you more flexibility - a later update can modify the options when required (so you don't need
to care about this in the future)

• 

using b) or c), you have to remove the .htaccess file again when updating• 
c) would apply the changes for all your PHP applications, which might be wished or not• 

So in short, I recommend option a).

Application

Configuring the application itself is done via its web frontend. One point already mentioned is the
configuration wizard for the initial installation (or a recovery), and the update wizard.

More settings can be adjusted via the Admin menu, in the Preferences section. Note that this will change the
defaults which may be (partially) overridden by the users preferences - so if you only want to adjust
something for yourself (and not for the guest and new users), you should use the dialog in the Edit menu
instead. Details can be found in the applications online help for these pages.

Configuration

Configuration ScreenThis is where you configure the application defaults for new users, as well as the settings
not to be changed by "normal" users: Selecting the item Configuration from the Admin menu brings you here.

The configuration screen consists of multiple sections - all available options are grouped by the area they
belong to. At the right end of each section header you find a small help icon: A click on it will open a new
window explaining what is to be configured here (context help). To give you a raw idea about the flexibility

Updating 3

http://www.php.net/


of phpVideoPro in terms of configuration, here comes an overview - for the details, please refer to the help
pages just mentioned:

Language Settings: Install/Update/Remove translations, and select the default language for the
application

• 

Movies and Media: Set defaults for the sound and video formats used, as well as details for your
media

• 

Cookies: Cookie details as whether to use them plus their expiry time, and session timeouts• 
IMDB: Detailed setup for retrieving movie data from the IMDB sites, as site(s) to use, cache settings,
and what data to use by default

• 

User Backups: If and how "normal users" may maintain backups of their own data• 
General: Settings not fitting in any other category, as printer settings, HTML header settings,
template settings, etc.

• 

Language Settings

phpVideoPro already comes with support for different languages. But the corresponding data (with the
exception of English) will not be automatically installed into the database, but are provided as *.sql files in
the setup/ directory. So it is the task of the administrator to decide which language(s) should be available in
the application, and which should be used by default.

Not all localizations are complete (we happily accept updates!). The developer himself keeps track of the
English and German ones, so these should usually be up-to-date. If someone decides for an "incomplete"
localization, missing terms will be substituted from the English file.

In this section you find the following settings:

Setting Comment
Scan for new
language files

Tells phpVideoPro to check the setup/ directory for new language files available, and to
update their availability in the database

Install
additional
language

Makes this language/localization available to the users. The drop-down box only shows the
languages marked available in the database, so you might need to check the previous entry
first.

Refresh
language

Especially interesting after an update (where it is performed automatically for the English
language), or when you've got an updated language file from other sources. For the here
selected language, first all translations will be purged from the database, and then replaced
by the terms from the corresponding file.

Delete
language Removes all corresponding localizations from the translation table.

Primary
language

This language will be set as Default for "new visitors" - they of course can change this for
their sessions then.

Movies and Media

You are right if you now expect settings concerning movies and media. In the following table, the User
column specifies whether a setting can be overridden on the users preferences page:

Setting Comment User
Editable
Media

Being a relict of past times, this was intended to be used for remaining free space on
VHS tapes. No
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Remove
empty media

Another relict: When you "deleted" the last movie from a tape, you probably wanted to
reuse the tape. Today this usually means you gave away the medium, and thus want to
activate this function.

No

Default for
Label Info

When talking about relicts… To also make use of the last few meters of your tapes, you
might have decided to record some video clips from MTV. But including them on the
tape label would render that unusable. That's why one may decide to not include certain
records here. But today, I'd recommend to enable this feature.

Yes

Default
Sound
format

Here preferences may differ: recordings from TV are still mostly in Stereo, while
bought DVDs are more likely to use Dolby 5.1. Preselecting the right format may ease
data collection later on.

Yes

Default
Color
format

The same - just that here Color will be the right selection in almost all cases - except for
fans collecting only ancient movies… Yes

Default
Screen
format

Today mostly 16:9 - you don't even get notebooks with other screens… Yes

Default
Video norm Country specific. Except for the US (NTSC), you probably will chose PAL here. Yes

Default
Audio
language

The most expected audio language for new records. Yes

Cookies

Setting Comment
Enable
Cookies

Shall phpVideoPro use cookies to safe user preferences? If this is deactivated, they will be
stored in the database instead.

Lifetime How long cookies shall be valid (they will be removed once they become invalid). Session is
a special case where they are removed as soon as the user closes the browser.

Inaktivity
Timeout

A security setting: If some logged-in user is inactive for a longer interval, the session will be
invalidated and the user needs to login again.

IMDB

The IMDB settings only have an effect if the IMDB API is installed along. The "User" column again tells
whether a setting can be overridden by user preferences:

Setting Comment User

IMDB Site There are a couple of localized IMDB Sites around, offering the advantage to search
for the localized movie title. Chose the best matching one here. Yes

Alternative
IMDB Site

Disadvantage of the localized sites is they only localized the interface (not the
content), which makes it hard to parse by the API. The added value of teaching the
API all those localizations does not at all correspond to the work needed for that - so
the API instead requires an English site for this, which is to be specified here.

Yes

Data to
transfer Default for the Checkboxes on the IMDB Search result page Yes

AutoClose
search window

When the data has been transfered to the main window, the search window is no
longer needed but can be closed. Disabling that is only needed for debugging
purposes.

Yes

No
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Enable IMDB
Cache

A Cache is only useful if the same data are retrieved more than one time. If the
installation targets a single user, this usually is not the case. But if you have multiple
users, it can speed up things a lot.

Purge IMDB
Cache

How long to keep data cached. Older files then will be automatically removed when
the cache is accessed. No

Cache
directory

If caching is enabled, the files will be stored at this place - and the web server process
requires read and write permission to the specified directory. No

Use Cache for
new requests

Well, that's what the cache is for, right? Everything else is for debugging and test
purposes. No

User Backups

phpVideoPro includes an own backup mechanism (as described for the admins interface in chapter Backups
separately). But since v0.9.5, not only the admin can manage backups - in a restricted way, the users also can
do this for their own data, if the configuration permits. The corresponding items then appear in the Edit menu:

Setting Comment
Download
Backups

Permit "normal users" to download backups of their own records. To do so, they additionally
require the Browse permission.

Create on
the Server

Permit "normal users" to store backups of their own records in the servers configured backup
directory. Additionally to the Browse permission for the user, the backup directory (configured
in the inc/config.inc file) must be read- and writable by the web server process.

Restore
Backups

To restore the records of their own backup files (which also can be created by the admin, but
must be stored in the configured backup directory) the user additionally requires the
permissions to browse, add, and delete records.

Backup
Count

How many backup files per user should be kept on the server. If this amount has been reached,
the oldest backup file will be deleted on the next backup attempt made by the user. It will
however not be checked when the admin creates that backup via the admin backup page.

General

This section contains everything not fitting in the other places. The "User" column again shows whether a
setting can be overridden by user preferences:

Setting Comment User

Template Set
To adjust the look-and-feel, phpVideoPro offers different template sets (see also
CustomizingManual for the creation of your own template sets). Here you define the
default for new visitors/users.

Yes

Editor
For text areas (especially the comments on movies) a WYSIWYG editor can be
used. One man's meat is another man's poison, so you can define whether it shall be
used by default, or just on demand.

Ja

Bubble-Help Display some hints when the mouse is moved over certain places. Again a
two-edged sword, so we leave it to you to enable it or not. Yes

Printer

Refers to the PostScript output for labels (see also Printing in the UserManual, or
PSLabel Management in the administrators manual). In order to place them
accurately, we need to know the printers borders. If your printer is not listed here,
first try one of the others. If you find no matching printer, you have to create a new
entry (see the corresponding item in the admin menu).

Yes

Browser/Proxy
Cache

Here you can define whether phpVideoPros pages may be cached by
browsers/proxies. Dynamic pages (like these) tend to change, so if you are just

No

IMDB 6

http://en.wikipedia.org/wiki/WYSIWYG


reworking all your entries, better forbid them to be cached until you're done.

HTTP
Authentication

This is only interesting for integration of phpVideoPro into a site already is
protected by HTTP Basic Auth. phpVideoPro then tries to use that realm, which
requires the user information to be the same on both ends: Changing the password
on one end thus requires it to be changed on the other end as well. If you don't need
this functionality, disable it.

No

Display limit Limit displayed lists to this number of entries. If you got many records, you will
praise me for this  Of course you can skip through the pages to see all entries. Yes

Lines per page Other than the previous point, this refers to the page breaks for ASCII lists to be
printed, as you find them in the Print menu. Ja

Date format For the date displayed in lists. Yes

Site Info Here the administrator can affect the title of the browser window: phpVideoPro
vx.x.x @ <site info> [pagename]

No

Filters

The filter settings are described in detail in the UserManual. The screen looks exactly the same - only
difference is that what the admin sets up is the default pre-setting for new users/visitors and stored into the
database, while the users variant is their personal one and usually stored in their cookies.

User and Session Management

As with all administrative functions, you get access to the User and Session Management via the Admin menu
- of course only when you are logged in with administrative privileges. You can create/modify/delete users as
well as their past or active sessions, as we will describe in this article.

Manage Users

User ManagementFrom the Admin menu, select Manage user accounts to access this function. This will bring
you to a screen where you can easily modify already existing users: Simply check the permissions the user(s)
shall have, uncheck permissions you want to remove (see screenshot). Don't forget to click the Submit button
to save your changes. Click on the trashcan icon to remove a user, or on the edit icon to edit user details such
as the users comment or password.

To add a new user, simply click on the Add User link in the lower right of the form. This will bring you to a
new page where you can enter the details for the new user to be created - which are basically the same as you
see in the screenshot, plus the password. Of course, each user can change his/her own password at any time -
and possibly should do so after the administrator has created the new account (or reset the password the user
has forgotten).

Manage Sessions

Session ManagementThe item Manage Sessions from the Admin menu brings you to a screen like in this
picture, where you can manage active and past sessions. you will see session details such as who has logged in
from what remote machine at which time, last activity of this session, and whether the user already logged
out. By clicking the associated trashcan icon, you easily can terminate a session. Since users tend to forget
their logout, or simply to "clean up" historical data, you also can purge older and/or ended sessions.
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Translation Management

Language selectionphpVideoPro not only supports multiple users, but also can support multiple languages - so
you can localize the application if needed. Each user can select the language (s)he likes in his/her preferences.
Some languages are already shipped with the application, so you can install them on the Configuration screen.
Others are not yet available, and we wait for you to provide them for the next version. So whether your
language is completely missing, misses some phrases or needs some corrections, you can do so from inside of
phpVideoPro.

The first screen after selecting Edit Translations from the Admin menu lets you chose the target language you
want to edit the translations for. Not only installed languages are shown here, since it may be you want to
create a complete new language file. If the language you selected was already installed, existing translations
will be loaded when you submit this initial form.

Edit TranslationsSo the following screens allow you to edit the translations for the language selected. For each
term, the table shows you the (internal) translation code used by the application to identify the term together
with the original translation and, if available, a comment describing what is meant (e.g. in which context it is
used). And of course there is one editable field per term to allow you defining the (new) translation for your
language.

A few more elements of this form may be worth mentioning. One is the "Shortkey Bar" at the top of the table,
which lets you jump to the page starting with the clicked letter. Very useful if you e.g. create translations for a
language not yet supported by phpVideoPro: Since there are many phrases needed, you probably won't do
them all in one run. Just remember where you stopped, and the shortkeys let you jump to the desired page - or
at least close to it.

The other elements you will find at the bottom: First this is one Update button to save your changes (which
you should always do before switching to another page), and second a link to Save target translations to a file.
The latter one also is very important: We would really appreciate if you send us the resulting file, so we may
include it with future versions of phpVideoPro.

The other navigation elements are self explaining: Arrows to move one page forward or backward, and the
same to move to the first resp. last page.

A last word on the translations: Terms which are exactly the same in your target language as they are in the
fallback-language (English) you must not translate - they will be taken from there. By not translating them
you keep the database smaller and thus faster - and the application needs to load less data, which again speeds
it up.

Technical Data

Categories

Manage CategoriesTo manage available categories, select Administrate Categories from the Admin menu.
This will present you a list of known categories as shown in the screenshot. For each categorie you can
modify the handle (which you normally should not do) as well as its name (which is better done via the
Translation Management. If the category is currently not used, you can make it invisible (i.e. it is not shown in
the list when editing a movie entry).

It is also possible to delete a category. If there are movies referring to the category you intend to delete, you
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will get an information telling you how many movies are doing so - and the category will not be deleted. For
now, you will first have to check up those movies and unassign the category before you can delete it. To
identify the movies in question, you can use the MovieSearch function.

The last row in this table contains an empty set. This is intended to (optionally) add a new category to the list.

Movie Technical Data

Manage movie technical dataSelecting Edit Movie technical data from the Admin menu brings you to this
screen. Here you can setup technical details to be associated with your movies, like screen, color and audio
formats, as well as languages you want to be presented to chose from for the audio and subtitle tracks and
available media types you use to store your movies on.

Nothing can be directly edited on that screen - but using the trashcan icon, you can directly delete single
items. To modify existing sets, just click on the edit icon - or click the Add entry link to add a new set. The
opening page lets you define a name and a short name to be associated.

Clicking on the link named Edit availibity of languages for audio and subtitle will present you with a table of
all languages. Here you can neither delete nor add a language - but you can define whether it should be
displayed for audio resp. subtitle when editing a movie entry. You should for sure limit the amount of entries
enabled - the larger their number, the harder they are to select for the resp. track (and the shorter the easier).

Disk Types

Manage Disk TypesHere you can define more details to the media types setup in the previous section. You
reach this screen via the Admin menus Edit Disk Types item. Consider a disk type to be a "more specific
media type": So e.g. a VCD can be rewritable (or not), and even this in different formats (+R,+RW,-R,-RW).
Similar things apply to DVDs (writable, rewritable, Dual Layer). Moreover they can have different sizes, and
support different features (Long play modi for VHS tapes, Region codes for DVDs) - all this is to be defined
here. Later on, when editing your movie entries, you can select from these entries to specify very precisely.

You already know the trashcan icon and what it is for: Clicking on it removes the associated entry - after
making sure you really want to do so. The empty line at the end of the table again is for adding a new entry.

Printers

Edit PrintersVia Admin⇒Edit Printers you find the page described here. This is not about installing and
configuring drivers, since phpVideoPro is not accessing the printers itself - but rather generates PostScript
code to be printed. But in order to position the labels correctly on the corresponding sheets, it needs to know
the borders the printer uses. This is what you configure on this page.

Names are hollow words here, so if you find another printer configured here having the values already set
correctly, feel free to modify the name to reflect that fact. Otherwise you have to find out the correct values,
maybe by trial-and-error: Simply print a logo on normal paper (which is as thin as possible), and put the result
on top of a sheet to see whether it overlaps correctly, scale the difference, and adjust the values here
correspondingly. Once there is no longer a difference, your printer is configured correctly with phpVideoPro.
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PSLabel Template Management

Edit LabelPacksThe PSLabel templates are used for the label printing and organized in LabelPacks. To
manage them, select Edit PSLabel Templates from the Admin menu. The page this will lead you to (see
screenshot) will give you an overview on LabelPacks installed and, after clicking the Check for Updates link
at the end of the table, also about updates as well as new/additional LabelPacks available on the projects
server.

Moreover it lets you perform some actions on each LabelPack: Display information (including a "contact
sheet" image to see how the contained labels look like), edit the contents, and install/deinstall the LabelPack.

Edit LabelPack contents

Edit PS LabelsClicking on the edit icon next to a LabelPack on the screen shown with previous paragraph,
you can view (and modify) the contents of that pack - i.e. the single templates. Again you can use the trashcan
to delete a template you don't like, or click the edit icon to show/modify details as name, size and type. The
files used you will only need to edit when creating your own LabelPack - same applies to the sizes.

Adding new entries is not intended here. Creating LabelPacks is described in the integrated help system of the
application (an article here maybe follows in the future).

(De)Install LabelPacks

(De)Install LabelPacksClicking the actions icon on the main screen will open a new window, which will
display available actions for the selected LanguagePack. Which options are available depends on your setup
and whether the selected LabelPack is already installed. There will be always an option to download the latest
available revision. If you already downloaded the pack and unpacked it into the pslabels/ subdirectory of
your phpVideoPro installation, you will also be able to install that revision (i.e. to register its files with the
database). If the LabelPack was already installed, you will also find the option to uninstall it (i.e. unregister
from the database).

If the pslabels/ directory is writable for the web server, there will be two more options: You can
download the LabelPack directly to your server and have it installed automatically, plus, you can deinstall
(unregister) it and have the application also deleting the files belonging to the LabelPack.

Data Administration

Backups

Backup ManagementBackup and Restore Management for your phpVideoPro data you find in the Admin
menus item Database Backup. The form shown (see screenshot) allows you to select the backup type and
whether the resulting backup file should be compressed on one side, and on the other side lets you chose an
existing backup to restore from plus whether you want to append these data to those already existing in your
database, or to purge the old data first.

To use this functionality, you must define the backup directory in your inc/config.inc. This directory
needs to be readable and writeable by the web server (the latter is needed if you want to store the backups
directly on the server - without that, you can only create and download them). The reason why this is not
configurable via the web interface is to prevent people from abusing this functionality - though they needed to
have an account with administrative privileges to do so, plus access to the file system to place a file to restore
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from. But one never knows.

Sure you could simply do a database dump and file system backup. But the integrated backup of phpVideoPro
offers you some advantages over that:

no need to fiddle around with the database dump options• 
automated compression (on demand)• 
backup selected components or the complete database• 
backup all movie information using an phpVideoPro internal format allows transferring data even
between different versions of phpVideoPro

• 

easy way of appending data from one backup to the existing data allows e.g. merging data from
another phpVideoPro installation into yours

• 

Orphans

Files

Cleanup orphaned filesThe first question is: What are orphaned files? The screen accessible via the Admin
menus item Removal of orphaned files will tell you this in detail. Including a list of orphaned files found in
your phpVideoPro installation.

The only stuff saved to the file system (beside some cache which will be purged automatically) are image files
retrieved from the IMDB sites. As soon as you used the integrated IMDB search to retrieve movie details,
phpVideoPro will also save the image attached to that record, and insert a link to the movie description. If you
decide you don't want this image to be displayed there, and removed the link from the description, the image
file still resides on your disk - and then can be found (and removed) here. Simply click on the Delete button.

Database Entries

Manage orphaned database entriesOK - we got that with the files. But what (and how) can be orphaned in the
database? Some entries have certain relations: Staff members are associated with movies, movies belong to
their respective owners, and so on. Though the application takes care for these relations, and e.g. deletes staff
members when you delete the last movie they are associated to, there may be situations where an orphan is
left (in old versions, this happened e.g. when you replaced a staff member in a movies record). So just in case,
here you have the possibility to clean them up. Or at least to see if there are any - and report a bug when you
are sure it is the applications fault…
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Customizing Manual
This little manual will show some examples on how you can customize phpVideoPro. Though this contains
issues about extending the application, it is not explicitly addressed to developers (we won't talk about
programming here). Most of the things described here can be done by everybody used to work with a
computer. The following topics will be covered:

CreateLabelTemplates — how to create templates for label printing• 
CreateTemplateSet — how to create an additional template set for the applications web interface• 
CustomizingManual/Localizing — how to localize phpVideoPro (let it talk to you in your native
language)

• 

Localizing the application

For those wonder what the term "Localizing" means: In short, you can translate it by "let the app talk to me in
my favorite language". On the UserPreferences page you already learned that there can be languages selected
to be used in the application. While in the "original configuration" everything is in English, when switching
the primary language to e.g. German, the Edit menu would be named Bearbeiten, and the corresponding help
page would be in German, too.

If your favorite/native language is not present (or incomplete), you may be annoyed by either the mix
(phrases/help pages not present in the primary language will automatically be substituted by the English
"originals") or complete absence of your favorite language. But it is up to you to change this - I (the author of
the program) cannot speak all languages and thus not provide all localizations. So this depends on people like
you, creating the localizations and sending them to me for inclusion with future versions.

What is most often misinterpreted: You don't need to do all of the work, if your time does not permit. Even if
you just did part of it (say, a couple of phrases or help pages), please send them to us - somebody else may
continue your work, and thus you may get updated files in turn.

Localize the Web Interface

Localizing the web interface basically is editing the translations available. This is described in the
TranslationManagement article.

Localize the Online Help System

The online help system is using an older version of the iFAQMaker API - which may be replaced by the
recent version in the future. So you can check the iFAQMaker project for what the syntax of the files is. Not
all macros described there are available, but the syntax for variable replacement, translations and blocks is the
same. Wiki syntax is not supported yet (as long as phpVideoPro uses the old version directly integrated with
the code - and doesn't take the API as dependency as this is planned for the future).

So the job is not very difficult, and again the tasks are quite clear:

Copy the file(s) you want to localize from the help/en/ subdirectory to the directory of your
language (identified by the 2-letter international code). As an example, for Finnish this would be
help/fi/ (you can find all the keys listed in the setup/tech_data.sql file. If the directory
does not yet exist, simply create it. Alternatively, you can also start with an empty file.

1. 
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Edit the file(s) by translating from the English file. This does not need to be literally, but should be
understandable. Moreover it is recommended to keep the structure (title blocks), so references will
work across languages (e.g. from an English substitute of a file missing for your language).

2. 

That's it. If you selected that language as primary language in your configuration, the files you are created will
automatically be detected and used. Again, please consider sending your work to us for inclusion with future
versions.

Creating templates for the application

To create templates for the application, you need at least some HTML knowledge - all the layout is done by
HTML and CSS, as it is with web pages. Besides from that, there is not that much to explain - the tasks are
clear:

Guess a good name for the new template set you are going to create. To have an example to explain,
let's call it "babylon5" here

1. 

Go to the templates/ subdirectory of your phpVideoPro installation and create a subdirectory by
this name. So based in the applications main directory, in our example this would be
templates/babylon5

2. 

To have something to start with, you may copy the contents of the templates/default directory
to your new directory. This way you make sure you don't forget a file, and also have the required
placeholders (the tokens in the {curly braces} which will later be replaced by the applications data)
already mentioned in the right files. Also you have the definition of data blocks where they belong
(that is what looks like HTML comments - don't remove them, they are essential! ).

3. 

Now you can start your favorite HTML editor and modify the HTML code within these files. Again:
Make sure to keep the place holders and block marks - or the templates won't work!

4. 

If your new template set needs some JavaScript code to be present for all pages, there are two special
files that can be used: if there's a file called top.js present in the templates directory, it will be
linked into the page header. A file named foot.js in the same place will be linked to the end of
each page.

5. 

Once you finished editing these files (i.e. your new template set has been created), you may go to the
UserPreferences page and activate your template set. phpVideoPro will automatically detect the new
directory and offer the new template set to you, so there's nothing else to do in the configuration.

6. 

If you are satisfied with your work, please consider packing the directory into an archive (*.zip,
*.tar.gz, or whatever you use) and send it to the developers, so it may be distributed and other
people can use it as well. Of course, credits would go to you!

7. 

Creating Label Templates

As you probably already learned in the UserManual, phpVideoPro uses templates also to create labels for your
media. We already described there that two different label engines are built into phpVideoPro. Since they
differ a lot, they cannot share their templates: Those created for one system cannot be used by the other.

Few templates are already shipped with the application, some more can be downloaded and installed via the
application itself (as described in the AdminManual). But still it could be that you either don't find anything
you like (there's no accounting for taste), or for other reasons need some other, special templates. So this
article describes how to create them.

One more word before we go into details: Once you created a set of templates, we are interested in a copy.
Other users maybe interested in using your creation as well! So if you don't mind (and the templates created
are not too personal to you), please send them to us, so we can make them available for other users as well.
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Though nobody did so up to now, I don't give up hope that some day I will have at least one "third party
template set" to offer 

Label Systems used

The GD Label system (as already introduced in the UserManual for printing) is the first label printing system
introduced to phpVideoPro many years ago. It uses PHPs GD library API to create labels from image files.
Development for this system already stopped some years ago in favor of the PS labels. Not that they are
themselves easier to handle - but with Postscript files it is much easier to achieve exact placement of objects
on a page, which is necessary if you want to use self-adhesive label sheets, which are available from different
vendors.

Still, there are reasons to decide for the one or other: Your system may not be prepared to use Postscript (oh,
you are not using Linux?), and you don't want or can't install the free Ghostscript to add this support - this
would be a reason to decide for the old GD Label system. Or your PHP installation lacks the support for the
GD library - which would be a clear reason against it and for the PS Label system… This is why we decided
to let the old label system remain in the application, though we favour the other one.

GD Labels

As already explained above, the GD label system uses image files to create labels, utilizing the GD library -
that is, we are working with graphics and graphic functions to create the final label, applying the text to the
image file. We found it best to use PNG at that time, since there have been issues with JPeg (licensing stuff
made PHP removing the JPeg support in some versions), so what you basically have to do is create some
*.png graphic files and attach configuration files to them. But of course, we will describe that more
precisely:

Labels are created/configured within the labels/ subdirectory of your phpVideoPro installation. There are
(at least) two files to consider. One is the configuration file <name>.config, and one (optional file) is the
"empty" label image (the label as it should look like, just except the data on it - <name>.png). Both have to
have the same name - if you e.g. call the config file my_favorite.config, the graphics file to use with
this config has to be called my_favorite.png. If there's no *.png file available for the *.config,
that's no problem: an empty template will be created having white background, and the fields specified in the
*.config will be drawn with lines.

In the *.config file, as you may have guessed, you configure how the label should look like. Make sure the
values you enter here (i.e. width, height and the coordinates for the fields) match your "empty" label image if
you want to use one. Since the config file is included as PHP source, you may use e.g. the PHP include()
command to base a set of labels on the same dimensions. This eases creation of large sets of labels, using the
same size and position of fields but just differ in motives.

The configuration file

Here comes an explanation of the configuration variables you have to use:

Variable Explanation
width, height the size of the label

maxlines how many lines of text should be put on the label in maximum. If you have many
movies/movie clips on one medium, not all of them may appear on the label then.

nr_coord, the coordinates of the fields using the "x1,y1,x2,y2" format, where "x1,y1" represents the
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main_coord,
symb_coord

upper-left and "x2,y2" the lower-right corner of the field. In the first field we'll place the
medium's number (without the media type), the second one holds all the data (see "entry"
below), and the third one is a symbol's place like I use to have on my labels (that ship with
phpVideoPro). This symbol field is not filled by phpVideoPro itself.

entry

this is either a string (if you just need one line of text per movie, e.g. for video tapes side
labels) or an array. You can place plain text in it (will stay the same on all labels), plus use
variables to be replaced by the movies data. Variables are to be marked by {curly braces}.
The next block contains a list of available variables.
You can mark one line of the array to hold the title, i.e. using a font different from the other
lines, by making its first character a "*".

Variables that may be used in the "entry" variable:

Variable Explanation
title the movie's title
length length of the movie (hh:mm format)
country, year as the name suggests, country and year the movie was produced
counter1, counter2 Start/Stop counters (only used by old video recorders)
aq_date date the movie was acquired
source where you got the movie from
actor1,…,actor5 actors 1..5 (format "firstname lastname")

actors12
enumeration of actor1 and actor2 ("actor1, actor2"). This considers
undefined actors as well - so if e.g. actor2 is not set, it would be the same as
actor1 above. This rule applies to actors35 and actors variables as well.

actors35 same as actors12 but for actor3, actor4, actor5
actors same as actor12, but enumerates all (set) actors
director the movies director
music the composer of the soundtrack
fsk the PG (aka FSK, MPAA)
cat1,cat2,cat3 the categories
comment the movies comment

mtype,mtype_short,cass_id,part Media type/type abbreviation/number and the movie's relative number on the
medium

color color, b/w or 3d
pict 4:3 or 16:9?
tone Mono, Stereo, Dolby Digital 5.1, etc.
tone_short same in the format "1.0", "2.0" .. "6.1"
lp whether a longplay mode was used
commercials whether the movie is interrupted by commercials

PS Labels

As the name suggests (and we already mentioned before), this label system uses Postscript. Postscript files are
generally plain ASCII, so they can be manipulated easily. To embed images, we use EPS - this way we can
even embed JPeg files.

PS Labels are managed using LabelPacks - each LabelPack being a collection of labels. So again, creating
templates for this system consists of two steps: Creating the EPS image files, and creating the configuration
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file for the LabelPack. We will explain both on the example of labels for CD/DVD media.

Creating the EPS images

Create a squared image, round the corners (to safe ink). Adjust the brightness so the text applied to the
label will be easily readable.

1. 

Resize the image to about 470x470 pixels at 72 DPI2. 
Convert the image to EPS format (e.g. using ImageMagicks mogrify}} command:
{{{mogrify -format eps2 -colors 256 +dither <imagefile>

3. 

Give the image a descriptive and unique name (since all these files will reside in the same directory
even with files from other LabelPacks, it may be a good idea to prefix it with the LabelPack name)

4. 

Creating the configuration file

To create the configuration file, you may use one from an existing LabelPack as template. They are usually
well commented, and thus should be easy to adapt. The name of the configuration file, which resides in the
same directory as your EPS images created, should reflect the name of your LabelPack and have the file
extension .pvlp.

Though the existing configuration files are well documented, the format will be described here:

All empty lines and those starting with a hash mark ("#") will be considered comments and ignored for the
processing. The first "real" line must specify the packs revision: Usually you start with "rev:1", and increase
the number on updates.

The next line will hold the packs general information. It starts with the word "pack" followed by a colon and
the revision, and then come (separated by semi-colons) a short name for the LabelPack (one word), a more
descriptive name, a description, and your (nick) name as creator. An example would look like this:

#pack:revision;sname;name;descript;creator
pack:1;pvplsolsys;Solar System Pix CD/DVD Labels;CD/DVD labels with motives from our solar system;Izzy ([url]http://projects.izzysoft.de/?topic=progs;subject=phpvideopro[/url])

The next (and final) block lists up the templates you created. Each line starts with the word "file", followed by
a colon and the type id. Type IDs are:

ID Type
1 VHS Top Label
2 VHS Side Label
3 CD/DVD Label
Again separated by semi-colons follow the name to be displayed, the file name of the EPS file you created,
the file name of the PS file the template is based on (just have a look at available *.ps files in the
pslabels/ directory: for CDs/DVDs this is usually common_cddvd.ps), and the coordinates of the
image (lower x+y, upper x+y - in our example "0;0;470;470". Don't wonder that this is upside down - that is
how Postscript works).

So an example configuration file could look like this:

# First give the revision of the syntax used here
rev:1

# Now comes the label pack general info
#pack:revision;sname;name;descript;creator
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pack:1;pvplsolsys;Solar System Pix CD/DVD Labels;CD/DVD labels with motives from our solar system;Izzy ([url]http://projects.izzysoft.de/?topic=progs;subject=phpvideopro[/url])

# Files belonging to this pack
#file:type;description;eps_filename;ps_filename;llx;lly;urx;ury
file:3;Callisto;callisto_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Dione;dione_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Earth;earth_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Europa;europa_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Ganymede;ganymede_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Iapetus;iapetus_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Io;io_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Jupiter;jupiter_cddvd.eps;common_cddvd.ps;0;0;470;470
file:3;Mars;mars_cddvd.eps;common_cddvd.ps;0;0;470;470

Of course: If you wish, you can add much more comments inside. The original file I pasted this from has
much more comments - I just stripped them to make the example more clear.
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pvptools
pvptools is a separately distributed package for the phpVideoPro admin. It contains several scripts for the
maintenance of the database (for details, see the table of contents on the right-hand side of this page). No
explicit installation is required for these scripts: You can simply unpack the archive where you like, and use
the scripts right away. Details on how to use them are to be found on the corresponding pages - as well as in
the text files of the archives doc/ directory.

Installation

Requirements

Of course the scripts require phpVideoPro itself to be installed - as they make no sense without that. Next to
this, you will need the command-line version of the PHP interpreter, as these scripts are not intended to be run
from a browser.

Take care to check the text files mentioned above for the required version of phpVideoPro - if this condition is
not met, the scripts probably do no harm to your database, but they will most likely fail to do their jobs. Best
is to always use the latest version of the tools with the latest version of phpVideoPro. On an installation of
phpVideoPro v0.9.3, for example, the scripts of pvptools v0.1 will fail due to changed database and code
structures, so you have to use v0.2 here.

 Before you run any of the IMDB scripts, go to your phpVideoPro web interface, log in as admin, go to
admin→configure and check the IMDB settings that either caching is disabled or a valid cache directory is
specified. Otherwise you may destroy parts of your installation.

Download

The latest (and previous) versions, as well as the changelog can be found here. The latest development code
can be downloaded using this link.

Installation

There is no special installation required. Simply unpack the downloaded archive into a directory of your
choice, and keep the script files together with the configuration file in the same directory. Some configuration
will, however, be required - and discussed in its article.

Configuration

Starting with v0.3 of the pvptools package, all configuration takes place in the file
pvptools.config.php. This has several advantages compared with the previous behaviour (having the
configuration within each file at the top of it):

one central point for configuration• 
no duplicate settings• 
easier updates• 

The only disadvantage I can see so far is that now each script loads all configuration items (even those it
doesn't need) - but who cares for that?
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Structure of the configuration file

Still, the configuration file is a PHP source file - which will simply be included by the scripts. This means, we
need to stick to PHP code rules.

The file is split into sections (separated by double-line comments) and sub-sections (separated by single-line
comments). For this article, only the first section (named "Configuration") is of interest - everything outside
that is to be considered "code" that should not be changed by the user. So the following paragraphs will deal
with the sub-sections of the Configuration section.

Global Configuration

The first sub-section deals with the setup of your phpVideoPro installation(s). Since the pvptools scripts
utilize the phpVideoPro API, they need to know where to find it - and who is the admin in that installation,
having the required permissions. As you could have multiple installations on the same server, these settings
are arranged as an array - and its settings will be explained here reflecting the shipped example configuration:

Setting Default value Explanation

$instance["demo"]->dir '/var/www/phpvideo' "Root" directory of the phpVideoPro
installation

$instance["demo"]->adminID 1
The userID of the admin user. If you don't know
it, look it up in the phpVideoPro Web Interface
(menu Admin⇒Usermanagement)

$myinstance 'demo'

If you have only one installation (or just want to
work with one of them), define it here. If you
have multiple instances and need the scripts to
work on all of them, comment this out. This
will affect the syntax of the scripts (which then
expect the instance name as first parameter).

IMDB Updater Settings

The next sub-section deals with the settings for the two IMDB Updater scripts. So if you don't want to use
them, you can skip this.

Setting Default value Explanation

$instancedemo?→imdbid TRUE movie updater: whether to scan for IMDB IDs and update them if
found

$instancedemo?→rating TRUE movie updater: whether ratings should be updated when found

$stopafter 200 on each run, do not process more entries (movies) than defined
here

$ignore_cat "cat_videoclip" movie updater: if a movie belongs to one of the categories
mentioned here, skip it. Values must be comma-separated.

$skip_id array() movie updater: array of IDs to skip. Please see the corresponding
article for details.

$skip_to 1 at what index the script shall start

$stop_at 100 at which index the script shall stop processing. Please see the
corresponding article for details on these settings.

$write_yt TRUE
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movie updater: whether to update the movies entry if the movie
title and year match

$write_aka_yt TRUE movie updater: whether to update the movies entry if one of the
AKAs and the year match

$write_yf FALSE movie updater: whether to update the movies entry when only the
year matches (dangerous!)

$write_yd FALSE movie updater: whether to update the movies entry when year and
director match

$report_nochange TRUE name updater: whether names with already set and correct ID
should be logged nevertheless

$compare_mode equal name updater: How to compare names. See the corresponding page
for details on the available modi.

$update_name FALSE

name updater: whether an existing names IMDBID should be
updated if it already was set, but we found the same name with a
different IMDBID. This could be the same person - but as well a
completely different one.

Backup Script Settings

This script only has one special setting: $instance["demo"]->cleandb (set to TRUE in the shipped
config) defines whether movies already existing in the database should be deleted prior to a movie restore.
Usually you will want them to be deleted first, since you want to restore the state of the backup. However,
setting this to FALSE, movies from the backup would simply be appended - which of course can (and in most
cases will) cause duplicates.

User Management

The user.php script allows you to manage your phpVideoPro users from the command line. Called without
any parameters, it will show its syntax - so you don't need to return to this page everytime 

Syntax

The script expects some parameters, depending on the action to execute:

Action Parameters
adding a user add <login> <password> <permissions>
removing a user remove <login> ![cascade|keep]
changing permissions perms <login> <permissions>
changing the password pass <login> <password>
display account details show <login>
list all defined users list

<login> means the user login in question• 
<password> of course is the password of that user• 
<permissions> is a string where the "key letters" of the permissions to set are simply concatenated.
These "key letters" are the bold ones here: Admin, Browse, aDd, Update, deLete. For the parameter,
they are case insensitive. Thus the string "bdu" would mean the permissions Browse, Add, and
Update. Missing permissions will be set to FALSE. In order to remove all permissions, simply set the
string to ".".

• 

IMDB Updater Settings 20



Removing a user

Removing a user is a special case. If you just use remove johndoe, it will probably fail if johndoe still
owns some media (this protection was added with phpVideoPro v0.9.5). So you can decide whether you
simply want to drop those media (specify remove johndoe cascade), or let them be owned by the
admin user, specifying remove johndoe keep.

 Be careful when you want to remove a user on a phpVideoPro installation prior to v0.9.5 - that protection is
not there then, and the user will be dropped without warning - while the media previously owned by that user
will be orphaned!

Backup and Restore

For Backups and Restores from the command line, the pvptools package provides the backup.php script.
Except for the running phpVideoPro installation and the PHP CLI binary, it has no additional requirements.

Configuration

The configuration is similar to that of the other scripts. For each of your phpVideoPro installations (probably
only one), there are 3 things to configure:

the base directory of your phpVideoPro installation (required to include the API)• 
the ID of the admin user (to make sure you can access all data)• 
whether all existing movies should be removed prior to a movie restore• 

Syntax

To see what parameters the script expects, simply run it without any parameters specified.

Backup

To create a backup, call the script with 3 parameters:

the name of the phpVideoPro installation you configured above1. 
the literal word backup2. 
what you want to backup: movie, sysconf, or cats3. 

Now keep in mind that everything is written to the standard output, so you need to redirect the output to a file
in order to store the backup. An example call could look like this:

./backup.php demo backup movie >movies_2009-05-12.pvp

For a test if everything works, better take something smaller (e.g. sysconf) and do not redirect the output. If
you see regular error messages, something went wrong. But if you see undefinable binary stuff, it probably
worked 

Restore

For a restore, things look a bit different. First, the file will be read from disk, and need to reside within the
backup directory specified in your phpVideoPro configuration. Next, the backup type (movie, sysconf, cats)
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will be automatically detected. Which leaves us again with three parameters:

1 - the name of the installation you configured above 2 - the literal word restore 2 - the name
of the file (without path) to restore from

So again, an example could look like that:

./backup.php demo restore movies_2009-05-12.pvp

Now you either get error messages, or the restore succeeded.

Get IMDB IDs for your movies

The script get_movie_ids.php is intended to find the IMDB IDs for those of your movies which have
them not yet associated, and update them into your database. The added plus of these IDs is found in multiple
things:

when viewing an entry, a click on its title can bring you directly to the corresponding IMDB page
(instead of issuing a search to find it)

• 

it gives you the possibility to do the same for the crew members (as described on the page
GetNameIMDBIDs)

• 

Just to give a few examples.

How it works

The script issues a search for the movies title against the configured IMDB site. Then, the result set is
evaluated for different criteria: Did the title match 100%? Or did one of the movies AKAs match? Is it the
same year? The same director? Depending on your settings, the movies record then is updated when certain
criteria match:

Setting Description Safe?
Value in the

shipped
version

$write_yt 100% match on title and year Yes, it is! TRUE
$write_aka_yt 100% match on title and year for AKA Yes, it is! TRUE

$write_yf
100% match on year, take 1st entry, i.e.
the first AKA listed

Not really - causes many false
positives FALSE

$write_yd 100% match on year and director To some degree - causes some
false positives FALSE

On a run against a database with 500 entries, the script automatically identified 270 movies with only 3 false
positives (all of them caused by the $write_yd mode, while $write_yf was not used at all since it causes
too many false positives), which is not that bad.

How to use the script

To put the hard issue first: It is not that easy as just to adjust the values and run the script once - you will need
multiple executions for sure, with changed values. It is never a bad idea to keep track what is done, so better
do all things in small steps. This can be done with the $skip_to and stop_at settings, picking a subset of
all your entries. You can also exclude entries using the $skip_id array. The values assigned to these
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variables refer to the set of movies selected - so the same number may refer to a different movie on a
subsequent run, if there have been some movies updated meanwhile.

A good process may look like this:

Check the settings in the configuration file and make sure that the directory and the ID of the admin
user are correct (the latter you find on the User Management page). The next two settings (update the
IMDBID and the rating) you will probably have set to TRUE.

1. 

Set all "writes" to FALSE, take the first group of movies i.e. by setting $skip_to=1 and
$stop_at=100. Run the script from the command line, while (optionally) spooling it's output to a
file, e.g. ./get_movie_ids.php demo | tee update.log - this way you can verify the
output even if it's off of your terminal

2. 

Watch the output for the word "MATCH" (yes, uppercase) - that's where the script found something.
If there are no false positives, you can set the corresponding "writes" (see above table) to TRUE and
run the script again. Otherwise, you may restrict your "frame" by playing with the $skip_to and
$stop_at parameters, or simply exclude the number in the square brackets by adding it to the
$skip_id array (comma separated values between the parenthesis)

3. 

Move on to the next "frame" by increasing the $skip_to and $stop_at values4. 

Conclusion

While this looks like a lot of work, it is still much faster than updating all database entries manually. And the
lazy can just use the first two "write" variables, do a fast run, and have at least some of the movies updated
without too much work 

Get IMDB IDs for your movies Crew Members

The script get_name_ids.php is intended to find the IMDB IDs for the people in your database - i.e.
directors, actors, composers - and update their entries accordingly. This is only done for people associated
with movies having already an IMDB ID - since this way we can be more sure to identify them correctly. This
means, you either already had retrieved your movie data with the IMDB feature in the past - or you will have
to run the GetMovieIMDBIDs script first. Running this second script will require much less work than the
other, and adding the plus of bringing you directly to the associated IMDB page for the crew members when
clicking their buttons.

How it works

The script will first query your database for all movies having an IMDB ID associated. Next, it retrieves the
crew information from the IMDB, and compares the names with those you have set for your movies. If it finds
a match, the crew members entry in your database is updated. What is considered to be a match, again
depends on your settings:

Setting Description Safe? Value in the
shipped version

$compare_mode How the names should be compared Depends on setting
(see below) "equal"

$update_name
When we found the same name with a different
IMDB ID, shall we create a new record?

Yes - but not
always wanted FALSE

A word to the $update_name setting: It is unlikely to be used at all - I cannot think of a possibility if you
not manipulated your database manually. But unlikely does not mean impossible - so if that happens, you can

How to use the script 23



either ignore it (FALSE) - or decide to have a new person entry created in your database, and that ID
associated with the movie then. More important is the compare mode used:

Compare Mode Description Safe?
"equal" Literally comparision of the strings, case sensitive Absolutely
"binary" Almost the same, but binary safe - probably not needed Absolutely
"binary_i" As binary, but case insensitive Probably
"soundex" Names sound similar. Has many false positives No

"metaphone" As "soundex", but much fewer false positives. A good helper for those vowels
with accents Somehow

How to use the script

This script is much easier to use than the GetMovieIMDBIDs script, and you will be finished much faster.
Chances for "false positives" are much lower, since here we already have a reference (via the movies IMDB
ID). Though, you will need more than one run for the best results. If you don't care for "as many as possible",
you can be done in one run with $compare_mode set to "equal" - this will probably already match 80% of
the referenced crew members, maybe even more. But again, we describe here how to get most out of it:

Check the settings in the configuration file and make sure that the directory and the ID of the admin
user are correct (the latter you find on the User Management page).

1. 

Set $compare_mode="equal", $skip_to=1, and $stop_at=999999 (or higher ), and run
the script with its output spooled to a file, e.g. ./get_name_ids.php demo | tee
update.log

2. 

Check the output. It is easy to tell which entries have been updated. If you get lost in a too large file,
just run the same command again with $report_nochange=FALSE (so it does not mention those
entries it did not need to touch), optionally move your previous log file away. Now you should easily
see which names could not be updated and why.

3. 

Based on the results of the previous step, you may decide to run the script again using a different
compare mode. This time, you may also want to go by little steps - or skip some entries: Play with
$skip_to, $stop_at, and the $skip_id array as suited (the latter is explained on the
GetMovieIMDBIDs page).

4. 

Conclusion

If you have been running the GetMovieIMDBIDs script before, or always gathered your data with the IMDB
feature, at least the first run is worth it - it takes you a minute to set it up and start it, and then you can leave it
alone 
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User Manual
This manual introduces you into the usage of phpVideoPro. You will learn about available features and how
to use them, and may use the manual as a reference. While the main intention of this manual is to get you
started with the application, you will probably better refer to the included (context sensitive) help system on
your later daily use of the program.

The following items are covered by this manual:

UserManual/UserPreferences: Adjust the settings to your convenience, and permit/limit other users
permissions to your movie records

• 

UserManual/Backups: How to maintain backups of your records• 
UserManual/MovieRecords: Create, edit and delete movie records• 
UserManual/Printing: Print labels and lists• 
UserManual/Filter: Use the filter system to limit listings• 
UserManual/MovieSearch: How to find records you created for your movies• 
UserManual/Lists: What lists are available for viewing/printing• 

Preferences

The user preferences can be divided into three sections: Preferences regarding the applications configuration,
permissions to your records, and your account data:

Configuration

User PreferencesIn the Edit menu you find an item called Preferences - which is where you define your
preferences regarding the applications configuration. Here you can chose your favorite localization from
multiple installed languages (as long as the administrator did install any additional languages - otherwise you
may ask him whether your favorite is available and that (s)he may install it), and set the default values used
for newly created MovieRecords. You also can define the settings for retrieving data from the IMDB sites you
prefer (this feature will also be discussed in the MovieRecords article), plus some general settings like which
template set to use, how many entries you want at maximum per page when displaying UserManual/Lists, and
what label sheet you want to use by default when UserManual/Printing labels for your media.

Detailed help for the settings and options available you will always find when clicking the help icon on the
right hand side of the corresponding section header.

Permissions on your Records

Record PermissionsEach user has his own sets of records - of course only if (s)he created some. By default,
they only belong to him, and nobody else can access them (except the admin). Selecting the entry Permissions
on your records from the Edit menu, you can grant other users the permission to read (see) your
MovieRecords, update and/or delete them, and even to add to your MovieRecords (so you might get the one
or other record as present). It is completely up to you whom you grant which permissions - and of course you
can revoke them at any later time. Changes take effect immediately after you hit the Update button.

Account Data

Account DataIn the upper right corner of the application screen (or at the right end of the menu bar) you will
find your login name. Clicking on it brings you to a screen similar to the screenshot next to this paragraph,
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where you can edit your account data. As a normal user, you can only change your password here. Having
administrative permissions, you also can change your (and other users - but for this better see the
AdminManual) login name and access permissions.

Filtering Movies

Filtering MoviesUsing filter is an easy way to limit lists to only display content of interest. Given relatively
global criteria (in opposition to relatively precise criteria using the MovieSearch), you can use it to e.g.
suppress things you don't want to have in the lists generally when browsing - e.g. "switch off" all your old
VHS tapes, or only list your favorite categories by default. As with the MovieSearch, selecting multiple
criteria will result in only those movies being shown in the list that match all of them. However, no movie
record will be skipped using the forward/backward buttons in the detail view.

There are two corresponding entries in the Filter menu: Unset Filter will reset the filter before showing the
form, while Set Filter will leave the currently set filter untouched so you can modify them.

Movie Records

Creating a new record

New DVD RecordTo add a new movie record to your database, you open the Edit menu and select the
submenu New. Here you find an entry for all media types configured with the application, and chose the
correct one - e.g. DVD if the movie was recorded to/bought on DVD. The application checks for the highest
media number in the database, and then presents you with a dialog to either accept the next media number
available or specify a different one. The media number consists of two parts: What is presented here is the
number of the medium, e.g DVD number 299. Movies on this medium will be numbered from 1 up, so the
first one would be DVD 299-01, the second DVD 299-02 and so on. So for the second movie on the same
medium you would manually specify the number presented in the dialog.

Once the dialog is closed, a screen is loaded similar to the one in the screenshot. Here you can specify the
details you wish to keep along. You can do so manually - or let phpVideoPro retrieve the data from the IMDB
servers:

Using the IMDB

IMDB SearchClicking the IMDB icon next to the title field will open the IMDB search window (see
screenshot), which will help you locating the required entry. If you already know the IMDBID of the movie,
you can enter it in the corresponding field, hit the corresponding Submit button, and directly come to the
details page. But usually you don't know the IMDBID in advance, so you will enter the movie name (or a part
of it) into the title field, select whether it is an episode or a movie, and hit the other Submit button.

IMDB Search ResultsThis will bring you to the search results page - which may take a couple of seconds,
since the IMDB server needs to be queried in the background. In case of a direct hit, again you will directly go
to the details page - but these cases are rare. On the search results page, the hits are presented best match first.
You can again click the IMDB icon to first visit the corresponding IMDB page for investigation. Click on the
name of the movie you want to retrieve data for to get to the details page.
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IMDB Search Result DetailsIt will again take some seconds until all the movie details have been retrieved
from the IMDB site, and finally you are presented with all of them to select which data you wish to use (see
screenshot). Depending on how you did setup your IMDB preferences, some or all details are already checked
for transfer to the main window. You can change the check boxes for which fields contents should be
transfered, as well as edit some of the contents: Select a different movie title from the alternative titles
available, select the PG valid for your country, change the runtime, rating and categories, select other staff
members than preselected, and edit the movie description. When you are done, click on the button labeled
Transfer data to edit screen, and the selected data will be transfered and, optionally, the IMDB search window
will close automatically.

Media Data

Now you only have to fill the missing data - again, some preselections are already done based on your
preferences (audio format, etc.), and the aquiration date is preset by the current date. Change the values as
required, and finally hit the Create button. Once the form is submitted, you can e.g. change the technical data
(media type and the like) by clicking on the corresponding fields, or hit the Edit button for other details.
Clicking the movie title or the names of staff members will bring you to the corresponding IMDB page.

Comments and formatting

While all fields only except normal text (and no formatting), some formatting can be used in the comments
field. Having retrieved (and added) an image from the IMDB site, you already see an example of how images
can be included. There are more "macros" available e.g. for embedding URL links, selected HTML tags are
also permitted. For details, simply use the integrated help system by either clicking the help icon in the title
bar, or opening the help menu and select from there.

Starting with v0.9.4, the comments field includes a WYSIWYG editor to help you with the most common
formattings. You can manually switch between this editor and the plain text area using the radio buttons next
to it, while the initial state can be defined in your preferences.

Edit/Delete/Move records

Moving recordsDeleting a movie record is obviously done by clicking the Delete button. You will be asked to
approve this, though. You also can edit the details again by clicking on the Edit button. And you can even
move a record - e.g. when you copied the movie from a VHS tape to DVD, or bought the DVD and threw
away the old tape. To do so, simply click on the media number, and you are presented with a form for this
task. The first drop-down shows you the highest media numbers recorded so far for each media type, so you
can check which would be the next. You probably don't want to change the original number, since this
identifies the record to copy/move. Specify the new media type and number, and then click the Copy or
Change buttons depending on the intended action.

Search for a movie

So your friends are there, and you want to watch a movie. You are known to have a good selection of titles at
home, and a well equipped home theater - that's why everybody is here. But which movie you want to watch?
Finding the right one is easy with phpVideoPro!
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Search for MoviesJust click on the search icon in the title bar (or select MovieSearch from the Edit menu) will
open the search page - and you have plenty of options. If you already know what movie you want to watch,
but don't remember on what medium it is - simply enter the name in the title field. Or you don't know yet - but
you know the genre, say you want to watch an action movie: Check the categories you want to list movies for.
Or enter your favorite actor or director in the staff field (and select whether you are looking for an actor,
director or what). You even can give a range of ratings, or limit the search to a specified media type and/or
language. Specifying multiple items will combine them and search for movies matching all the criteria
specified.

As a result, you are presented with a list of movies to select from. Check out where the corresponding media
is, lean back, and enjoy the evening!

Browse Lists

Browsing the MediaListThe View menu offers different lists to let you browse your collection. You can
display it by movie names (see screenshot), by actors, directors or composers. All these lists have at least
three things in common: They let you directly jump to movie details by clicking the movies media number,
you can go to the first, last, previous and next pages using the arrows at the top and bottom of the list, and
they respect the filter you defined. How many entries you will find per page is defined in your preferences.
Next to the more specific MovieSearch, this is a convenient way to browse your ever growing collection.

Printing Labels and Lists

With phpVideoPro you also can print labels for your media as well as lists of your movies. There are different
systems available, as we will show here:

PSLabels

Printing PSLabelsThe preferred label printing system is based on Postscript. This is not a problem on Linux
systems, since the printing engine used there also uses Postscript. However, on Windows computers you need
to additionally install Ghostscript to use PSLabels. Since Ghostscript is available for free, this should not be a
problem either.

The dialog for printing can be called via the Labels (PS) item of the Print menu. First you have to select the
label sheets you are using (there are label sheets available from different vendors, like Memorex or Data
Becker, having different designs) and, depending on their design, you will be brought to a form with the
corresponding fields (see screenshot).

Here you enter the information for which media you want to print labels. Leaving the number field empty will
not print a label on the corresponding position of the sheet. Next to the media information, you have the
possibility to select the label template. You have the option to show all available templates, or the templates
belonging to a selected LabelPack. Once you selected a template, a preview of the (empty) label will be
displayed along, so you can see how it would look like.
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GDLabels

Other than the PSLabels, the former variant still integrated with phpVideoPro uses PHPs GD Library to create
labels. Development of this engine was already stopped some years ago, but we decided to still have this
option in our application for those users who cannot use Postscript. GDLabels are still limited to VHS tapes,
since nobody ever provided any labels for other media. You can reach this label system via the Labels item of
the Print menu.

Lists

Printing lists uses neither of the two printing engines mentioned above - but rather generates the lists and
leaves the printing to another application of your choice. Though it is listed in the Print menu (as item Lists),
it is not printing them.

Lists can be generated in three different formats: Plain ASCII, HTML and CSV. The latter can be imported to
e.g. Excel, OpenOffice Calc or StarCalc and formatted there, as it simply delivers the sorted data as the first
option (ASCII) does. The HTML format has its optical enhancements here, and can as well be imported to e.g.
StarWriter or Word for (optional formatting enhancements and) printing. Of course you could also print
directly from your browser - but this is not that convenient for lists with many pages.

So what lists you can generate? First there are the media lists either sorted by media numbers, alphabetically
by movie names, or grouped by categories. Moreover you can print lists of your staff members (either actors,
directors or composers) sorted alphabetically, having the associated movies named along.

Maintain Backups

If the administrator permitted these operations, you can maintain backups of your records - if the admin did
not decide to do so, you are not in charge of. Hence it is possible that one, some, or all of the following
functions are not available to you. If you want them, ask the administrator.

Creating backups

If the admin permitted it, you will find the backup links in Edit⇒Backup. To create backups, you may have
one or two options available: Create a backup for download, or let it be stored on the server. Both may have
their advantages and disadvantages: If you can download the backup, you could decide to setup your own
installation of phpVideoPro and restore the backup here - but in order to restore it on the original server, you
probably need to ask the administrator to do so, and provide the downloaded file. If the backup is stored on
the server, it is automatically available for recovery when needed. So if you have both options available, it is
your decision which one to use.

Restoring data

phpVideoPro gives no upload facility, and probably won't ever. So if you've got your backup file downloaded,
you need to send it to the administrator and ask for a restore.

If you are so lucky that the administrator provided you with both, storing your backups on the server and
restoring from them yourself, you will find the corresponding entry again in the menu Edit⇒Backup. In case
you already created multiple backups, you may wonder where they have gone to. Don't worry, they are all
there on the server (up to the limit the administrator configured), but your restore will always be made from
the latest backup you created. If you need a previous backup to be restored, you again have to ask the
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administrator, who can do it.
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Terms
This article sums up wiki pages explaining terms used on this site:

IzzySoft — who's doing it• 
phpVideoPro — about this application• 
LabelPacks — they are used for label printing• 
Support — in case you need it• 
HelpNeeded — we need it!• 

IzzySoft

IzzySoft was founded in 1995 as a sideline to the owners study of computer sience (and, of course, to fund it
somehow). In the early years, IzzySoft mainly served web development and configuration/installation issues
for computers and small networks.

The focus changed in 2002/2003, when the last "normal employment" ended and the founder decided to start
freelancing for 100%. Since then, IzzySoft concentrates on Oracle support. This includes the service on site
(installation, configuration, tuning, etc.) as well as some pieces of software provided to the public under GPL
- like this project you are watching right now.

More information

IzzySoft Homepage• 
IzzySoft Oracle stuff• 
IzzySoft Software page• 
IzzySoft *.deb/*.rpm repositories• 

phpVideoPro

Intro

If you've got too many DVDs, VideoCDs and video tapes to handle, then you need a better system! That's
exactly why phpVideoPro was created. This program is all you need to get your huge collection under control.
It puts your information at your fingertips.

History

phpVideoPro was inspired by Bernd Rickers' VideoPro, which is available in a DOS-based clipper application
(latest release in 1994) as well as in a Windows version (starting from about 1993 - this is now known as
Video-5). phpVideoPro was designed using PHP because of the cross-platform abilities and the added plus of
having your information available anywhere at anytime.

Features

phpVideoPro Media list The program allows you to add and change entries as needed - on your request, it
utilizes the IMDB (Internet Movie DataBase) to retrieve information for this task, using the IMDBPHP class
also available separately. phpVideoPro can be configured to display your catalogue at will. You can view your
items in a list containing all of your entries or you can request the program to display a list of available free
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space on your homemade video tapes. You can view details of a specified entry, or display a list of all movies
with a certain actor. Moreover, you can have phpVideoPro printing labels for your media - just to mention a
few examples.

So you are able to keep track of what is what and what you're looking to add to your closet of treasures! The
filter functions help to sort through your catalogue by creating subsets and finding special entries within your
ever-growing collection, while the statistics page tells you how much it has already grown…

Data import from IMDB phpVideoPro is widely configurable. Making use of templates in almost all places, it
allows you to adjust its look and feel without any PHP knowledge (some HTML knowledge is needed for this,
however), or to create your own label design. You can even have phpVideoPro talking to you in your own
language (if it not already does) by creating a special language file using the built-in translation editor (don't
forget to place it here afterwards to have it included with future versions of phpVideoPro - and to be
mentioned in the "Hall of Fame").

The program does distinguish between DVDs, VideoCDs and Videotapes - new media types can be added
easily via the administration interface. While you may have enough tapes and DVDs to open up your own
version of Blockbuster, phpVideoPro wasn't designed to cater to video shops. The current release wasn't made
to log multiple copies of the same item. However, multiple simultan users are served together with their own
preferences and permissions with the help of cookies and a built-in session management. More to come.

If you want to know more, you may explore the (incomplete) Feature-List or try out the Demo installed on
this server.

Requirements

Database: either MySQL (v3.28.32 or higher, recommended is v5) or PostgreSQL (7.1 or higher)• 
a Webserver with support for PHP (tested only with Apache)• 
PHP5 (better 5.2+) with support for the selected database• 

Future

New features are planned, and development still goes on. The frequency of new releases is not very steady
and probably won't ever be - since "it's only a hobby", and there are so many others that require my presence 
But as long as I have not added all the features I need (see doc/2do), you can be sure that there will always be
a fresh release available within the next few weeks! And even if not, don't give up - sometimes it takes a bit
longer. So I close with my standard disclaimer: "This is only a hobby, I can't promise anything - I just ask you
to stay tuned…"

LabelPacks

phpVideoPro supports LabelPacks - which are a special form of organizing available postscript templates for
label printing. This means, phpVideoPro does not ship with all the label templates included - but you can
select which ones you need. This way the distribution archive is kept smaller (these templates will not change
with every release) - and you can install the templates you like while getting rid of unnecessary ones.

Installation of LabelPacks can be done right from within phpVideoPro - if the user has administrative
permissions, and the directories are writable for the webserver process. Since some may consider this a
security risk, the packs can also simply be downloaded from the admin menu, unpacked on the command line,
and then simply registered from the admin menu again. Starting with v0.9.1, there is also a preview for the
LabelPacks - whether already installed or just available on the server - integrated, to make it easier for you to
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find out which ones you would like.

To give you a glance, here are some of the packs:

Historical Motives Simple Pictures

Simple Colors Desert Motives

Landscape Motives Mountain Motives

Solar System Motives The original VHS tape templates

Support

Support Methods

The preferred support method is to open a ticket. To stay up to date with the responses, you may want to
create your own account first - check the links above.

Communication can also be done by mail - the documentation of the software usually gives you an address for
that. Still, we prefer you open a ticket - if not stated otherwise e.g. in a support contract.

Support Levels

Support is granted in different levels:

Basic On Demand Flatrate
Cost Free 70€/h 300€/year1

Reaction Time as time permits2 within 2 workdays3 within 2 workdays3

Code fixes as time permits2 ASAP ASAP
Feature Adds If we like4 If possible5 Not included6

Support by Mail Yes Yes Yes
Support by Ticket Yes Yes Yes
Support by Phone No Yes Yes
Support by IRC7 Maybe On Demand On Demand

Notes:

1 Packages are available to include multiple projects
2 Provided on a not payed base, other things may have higher priority (e.g. payed support)
3 Usually there will be an immediate response. Workdays are Mon-Fri except holidays
4 If not payed for, we decide whether we want to implement a new feature
5 If payed for, we want to implement a new feature and certainly will do. Exceptions are things which are not
possible to implement because of technical reasons.
6 "Not included" means you either have to pay separately5, or wait4
7 You may find somebody on irc.freenode.net in the channel #izzysoft - if necessary, place a
/msg to Izzy there.

Get your Support Level

For basic support, there's nothing you have to do - just file your request and wait for our response.
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For a "flatrate" you should contact us in advance, so we will setup a support contract. Your "flatrate support"
then starts as soon as we received your payment (if not agreed otherwise in the contract). Details on how to
contact us are to be found at the companies home page.

For "On Demand" commercial support, the first contact should be an email (or phone call, or fax). Before we
can start, we need an explicit order from you, together with at least a billing address. The price per hour
mentioned above does not yet include tax or money transfer costs, so you'll have to add these. Once the case is
closed, we will send you a bill.

Help Needed!

While most of the development is done by myself, there are things I can't handle. This is the place where you
come into play: Got the software for free, and want to give something back? Here you go!

BiDi Support

Already for a long time I struggle with the BiDi support, trying to enable Hebrew with the application. Up to
now mostly unsuccessfully: The BiDi stuff always messes some things up. The problem is, one never knows
in advance where the direction needs to change - hey, everything is generated dynamically. It's not only the
translations (and this is already hard to handle, not only because of the language fallback). Stored input for the
movies also may contain Right-to-Left stuff - or not.

If you are experienced with this kind of problems: Please contact me and offer your help on this, it is highly
appreciated! See the contact link below for details on how to find me 

Translations

This is something more easy - and the project is always looking for people to update existing translations as
well as add new languages. Since development is going on, new phrases are permanently added. Help for the
translation work thus is always welcome!

One part of this can be done using the integrated translation editor - this affects the web application itself with
its menus etc. A second playground is the online help - here are simple text files to edit. All in all nothing
technically difficult - and you don't need to install anything on your computer to do the job. So why not apply
for it?

Label Design

You probably know that phpVideoPro has a label printing system. To be true, there are two different label
printing systems available within the application: One is based on the graphics library called GD (this is the
old one), while the other uses PostScript ("PSLabels"). While the old one was designed years ago for VHS
tape labeling (and was never extended/updated since), the PSLabels now start to support CD/DVD labels (not
yet covers) as well with version 0.8.5 of phpVideoPro. Just a basic set of designs is shipped with the
distribution - and I must admit: They work, but they could look better…

So here again help is needed. For v0.8.6 of phpVideoPro, the tables for the PSLabel system will change a little
bit - for a new feature: I want to support "Label Packs". This means: You design collections of labels, I will
distribute them as separate archives, and the end user can chose which Label Packs to use.

What is needed therefore? A collection of graphics. They should be about 470x470 pixels in size. The colors
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should be selected such that the movies information we print on top is easy readable. Motives should be
neutral in so far that they match a collection of movies (i.e. they should not be special to a single movie).
When you set up some of these graphics, send them to me (any graphics format, I'll do necessary conversions
- prefered formats are JPeg or EPS). Of course, if you have questions and/or need closer information, please
contact me.

Testing

This is always needed, and if you find something weird, please report! Currently, we'd especially like the new
SQLite support be tested: Does everything work as expected? Some problems, which do not appear with the
other databases?
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